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Introduction  

About EZ-DNC / FilterMAX Help 
This help system covers two software products named as EZ -DNC and FilterMAX. Both programs share the same 
menu and command structure with the exception of the additional Optimize menu of FilterMAX which offers G-Code 
optimization by fitting arc/nurbs to linear moves. 

EZ-DNC 
EZ-DNC provides a single, complete environment for creating, editing, verifying and DNC transfer of CNC programs. 
The editor supports most advanced word processor features, special features include block renumbering, seeking by 
file contents and file comparison. You can communicate with up to 64 CNCs simultaneously using the robust DNC 
feature. The backplotting window lets you plot the current g-code file one move at a time or all at once. A very precise 
machining time estimator is located in the backplotting window. NC toolpaths can also be converted to DXF format 
using the Convert to DXF feature.  

FilterMAX 
In addition to the complete functionality of EZ -DNC, FilterMAX converts point-to-point G-code toolpaths to tangent arc 
moves or NURBS, resulting in files that are up to 98% shorter. Instead of cutting thousands of linear segments, the 
machine will cut tangent arcs, giving smoother surface finishes. Small linear moves can slow down a CNC Control's 
processing time significantly, arc moves generated by FilterMAX eliminate this delay allowing the machine to run much 
faster. Feedrates can also be optimized for sharp corner deceleration. 

 
 

About PCAM Solutions Inc. 
We are the developer of EZ -CAM family of CAD/CAM software systems originally created by Bridgeport Machines in 
1980. Since then over 10,000 users worldwide have benefited from EZ -CAM's powerful, robust and user-friendly 
features. Today, EZ -CAM under PCAM's management continues to lead the way with innovations in CNC 
programming. PCAM's team includes both software and machining specialists. This mix of expertise, combined with 
a close collaboration with a variety of machine shops, continues creating the optimal tools for making your shop more 
efficient. 

 

Software Development, Worldwide Sales & Marketing 
 
Contact :  PCAM Solutions Inc., USA, Sevket Tarhan 
Email :  sevket@ezcam.com 
Phone :  212-249 5832 
Web :  www.ezcam.com 
 

Installation  

System Requirements 
This software is designed to be compatible with Microsoft Windows 32Bit versions like Windows 95 / 98 or NT4. 
Operating System :  Microsoft 32 Bit operating system ( Windows 95 / 98 , NT4.0, Windows 2000) 
Processor  :  Pentium class 
RAM   :  min.  32 MB 
Graphic Adapter :  VGA / SVGA support 
Diskspace   :  about 12MB 
Others   :  parallel printer port for connecting Key-Ring 
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Installing the Software 
One of the Microsoft Windows 32Bit operating systems ( Windows 95 / 98 , NT4 / 2000) must be installed prior to 
software installation. The installation procedure will automatically create a directory, copy all the program files, and 
create a program group and icon. 
1. Insert the program CD in the CD-drive. 
2. Select the RUN command from the START Menu of Windows Desktop. 
3. Type X:\SETUP where X is the letter of your CD drive. 
4. Follow the instructions of the setup routine. 

 

Important ! 

It is not necessary to have the Key-Ring installed prior or during installation. Only when starting the software, the 
presence of the Key-Ring is checked. 
 

Connecting the Key Ring 
Packaged with the software is a protection device known as a "key". This "key" plugs into the parallel printer port at the 
back of the computer. The key is programmed by the software manufacturer to protect the software purchased with 
your package. 
 

Getting Started  

Overview 
This NC program optimizer utility is designed to address the needs of the advanced NC programmer who regularly 
generates complex 3D tool paths. The primary purpose of the software is to reduce the overall program length of 3D 
surfacing G-Code programs by, wherever possible, replacing chordal linear moves with arc moves using the standard 
coordinate plane selections (i.e. G17, G18 and G19). In doing so, a typical surfacing program can be reduced in length 
by as much as 90 percent while improving surface finish and smoothness as a result of the arc fitting. In addition to the 
arc fitting optimization, this software also includes an integrated NC text editor, a tool path verification mode, and CNC 
communications utilities, allowing a program to be edited, verified and downloaded to the CNC control via an RS232 
connection. 
 
The optimization process will yield the best results when used on surfacing programs that are cut parallel to either the 
X-Y, X-Z or Y-Z planes. When creating an NC program on your CAM system, try to use a machining strategy that will 
ensure this type of cutting. The optimized program will consist primarily of arc moves (G2/G3) in either the X-Y (G17), 
X-Z (G18), Y-Z (G19) planes with the remaining moves being linear (G1). This software will also fit arcs in programs 
that use other types of machining strategies, however the file size reduction will be much less. 
 
When optimizing an NC program that already contains arc moves, the software requires that the appropriate plane 
selection code (G17, G18, or G19) precede each section that contains the arc moves. Additionally, any program that 
contains incremental and absolute commands (G90 and G91) must have them on separate program lines that do not 
contain any X-Y-Z moves. 
 

Configuring Control Parameters 
This software is designed to be compatible with Fanuc controls and requires no modifications to begin optimizing and 
viewing files of this format. NC files that are formatted for other machine controls may also be optimized or verified, 
although certain information must be defined first. To configure the parameters for controls other than Fanuc, you 
need to know the following information: 

Program word letter addresses. 

Arc center format. 
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G-Codes. 

M-Codes. 

Macro definitions. 
Once the above information has been obtained, the appropriate information must be entered into the Register 
Settings, G-Code Settings and Other Settings dialog boxes. These dialog boxes are located in the Preview menu. 
 

Converting NC Files 
Note 
Do not use the Open command (located in the File menu) unless you wish to edit the original file before conversion. 
Loading the file before converting will take unnecessary time. 
 
To convert NC files 
1.  Click on Settings under the Optimize menu. Set the chordal and tangency tolerances to the values you require. 

Tolerances may also be set within the program by inserting $CT.001 (for .001 tolerance) and $TT1 (for 1 degree 
tangency) in a comment line. Use this feature to change the tolerance for roughing and finishing passes within the 
same program. If you require a radius designation of R to be output in the converted file, check the Radius Output 
box, otherwise I, J, K center values will be output. Click OK. 

2.  Optimized files are renumbered by the settings under Renumber. If you do not want line numbers in the new file, 
then enter 0 for both Start Number and Step Size. The default increment is 1. If your program is metric then 
change the Inch/Metric setting under Format. 

3.  Click on Convert under the Optimize menu and specify the NC file to be converted. Click OK. The message 
"Converting Lines to Arcs" will appear. When completed, the original number of entities is shown with the new 
number, along with the percentage by which the file has been reduced. Click OK. The converted file will now 
appear in the editor. You may use Preview to view the toolpath. 

 

Previewing NC Files 
The Preview command is used to graphically simulate the machine tool's execution of the NC program. An active 
window must be displayed before the Preview command can be used. Since the Convert command automatically 
loads the file into an active window, the Preview command can be used immediately after converting a file. 
To begin previewing a file, choose the Preview command from the Preview menu. A new window will appear placed 
on top of the existing window. The Preview window contains six buttons along the top of the window. Four of these 
buttons function similar to a VCR, allowing a file to be played in single steps, played continuously, stopped, or 
rewound to the beginning of the file. There is also a button used to adjust the viewing parameters such as the window 
center coordinates, the window size, or the 3D view orientation. This button appears as an X-Y axis. 
The simulation is started by choosing the button that has two arrows pointed toward the right of the screen (Run 
Continuous). Assuming that the view settings are adjusted correctly, the program tool path will display in the Preview 
window. The verification may be stopped at any time by selecting the button that contains a single square (Stop). To 
replay the simulation choose the button that contains two arrows pointed toward the left of the screen (Rewind and 
Clear) to rewind the file. To verify the program in a single step mode, choose the button that contains a single arrow 
pointed toward the right of the screen (Run Single Step).  
 
See also 

Preview...  
 

Saving NC Files 
Once a file has been converted and previewed, the last step is to save the optimized file. To do this, choose the Save 
As command (located in the File menu). A dialog box will appear allowing a new name to be specified. If desired, the 
original file may be overwritten by choosing the Save command. 
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Saving Your Settings 
Once the Preview and Optimize settings have been made, these parameter settings should be saved, allowing them to 
be reloaded at a later time. It is recommended that a settings file for each control be created. To save the settings, 
choose the Save Settings command from the File menu. 
 

Setting Optimization Parameters 
When optimizing a program, there are two settings that will affect the amount of file reduction and the smoothness of 
the machined surface. These two settings are Chordal Tolerance and Tangency Tolerance . If radius arc (R) format is 
required instead of arc center (I,J,K), choose the Radius Output check box. The following recommends tolerance 
settings for both roughing and finishing operations. 
 
Roughing Passes 
The larger chordal tolerance you can give, the more the file can be reduced. If you are leaving .020 of material, then a 
.010 tolerance will give you a good file reduction and still leave at least .010 of material for the finish pass to remove. 
Tangency tolerance should be set to 10 degrees to ensure maximum reduction. 
 
Finishing Passes 
To get a great finish and reduce hand polishing time, set the "chordal" or "surface" tolerance in your CAM system to 
.0003". For this software, chordal tolerance should be set to .0005". You may use smaller tolerances, but be sure that 
the tolerance for this software is larger than that of your CAM system. As long as your CAM output is controlled by a 
chordal tolerance, the output of this software will be closer to the original surface than the straight-line toolpath it takes 
in. In the above example, the maximum deviation will be .0005, not .0008. Larger finish tolerances have been used 
successfully, but finish may begin to be affected in some cases. Tangency tolerance should be set to 2 degrees to 
start. A lower tangency tolerance may slightly improve the part finish, but may also inhibit file reduction. If you can use 
a larger tolerance, the file reduction will be better. It is recommended that you raise or lower the tolerance one degree 
at a time and note the change in file reduction if finish is very important. 
 

Menu Commands  

File Menu Commands 
The File menu is comprised of a variety of commands which are primarily used to load and save files. Most of the 
commands within the File menu utilize standard Microsoft Windows dialog boxes. Refer to the Microsoft Windows 
users manual for more information concerning the loading and saving of files using dialog boxes. A list of the four most 
recently used files is displayed in this menu. Click on the desired file to open. This feature is particularly useful when 
you need to access files quickly. 
For more information click on the graphic below 
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Edit Menu Commands 
This software contains a full screen editor and a clipboard (a temporary memory buffer) allowing program text to be 
copied and reinserted into the active window. The Edit menu contains most of the commands that are used when 
editing an NC file. Many of the edit commands require that a text selection be made before any commands can be 
chosen. A mouse or the cursor keys may be used to select text and to place the insertion point. 
To select text using a mouse, place the cursor next to the characters to be edited, click the mouse once and continue 
to hold the mouse button down while moving the mouse to the left or right. When the desired characters are 
highlighted, release the mouse button to complete the selection. A single word that is separated by spaces, tabs or 
carriage returns can be selected by double clicking on the desired word. To select text using the keyboard, use the 
cursor keys to move the insertion point next to the characters to be selected, then while holding the SHIFT key down, 
move the cursor keys to the left or right to complete the selection. 

For more information click on the graphic below 
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Format Menu Commands 
The Format menu contains commands that control the format and display of the NC text file. Some menus function 
as toggles where they are either turned on or off as indicated by the check mark displayed next to the menu. 

For more information click on the graphic below  
 

  
 
 

Optimize Menu Commands 
The Optimize menu contains the parameters and commands used to control and initiate the optimization process. 
Before optimizing a file, make sure that all of the settings in the Preview menu accurately reflect the control format of 
the file that is to be converted. 
 
For more information click on the graphic below 
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Preview Menu Commands 
The Preview menu contains the settings used to define the CNC control format and the commands needed to 
graphically execute a part program file, simulating the machining process. Before the preview mode can be used to 
verify a program, the control parameters must be set through the Register Settings, G-Code Settings, and Other 
Settings dialog boxes. Once these parameters have been established, they should be saved using the Save Settings 
command located in the File menu. Typically, each control type requires its own unique settings, therefore it is best to 
save a parameter file for each. 
For more information click on the graphic below 

  
 
 

DNC Menu Commands 
The DNC menu is used to transmit NC files to and from a CNC control. The parameter settings allow the software to 
be configured to support a variety of controls. 
For more information click on the graphic below   

  
 
 

Automation Menu Commands 
The “Automation Menu” is the most important new feature of FilterMAX / EZ -DNC release 6 . By implementing the 
Sax Basic Script Engine, it provides the user with a Visual BASIC compatible macro language and a completely 
interactive design and development environment. In addition to the standard BASIC language support, the script 
language gives also full access to all functions and properties of the EZ-DNC text windows as well as other Windows 
applications like EZ -CAM which support OLE.  

For more information click on the graphic below  
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For more information on the macro Editor and the language please see the Sax Basic help. 

 

 

Window Menu Commands 
The Window menu provides you with three standard options for viewing the contents of your files. As you open files, 
the Window menu records the name of each file. A check mark placed by the name of the file indicates that the file is 
in active window. Only one window can be the active window. To make another window the active window, click the 
title bar or select the file from Window menu. 
For more information click on the graphic below  

  
 
 

Tech Notes  

Overview Technical Notes 
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G90 and G91 Commands  
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Optimization Failure  

Reference Information 
ASCII Character Codes  
 
 

Bridgeport Controls 
If you have a control which requires absolute arc center coordinates or reversed G2/G3 directions in the G18, G19 
planes (i.e. Bridgeport Controls), you must check the appropriate box in the Other Settings dialog box located in the 
Preview menu. 
 
See also 

Other Settings...  
 

Digitized XYZ Files 
Digitized XYZ files may be converted by adding G1 to the beginning of the file. Tangency tolerance may need to be as 
high as 30 degrees to get a significant reduction for laser digitizing. 
 

G90 and G91 Commands 
G90/G91 commands can be made anywhere in the file with or without XYZ input.  If G90/G91 is specified in the middle 
of a XZ or YZ planar pass, optimization output is performed according to the G90/G91 status at the beginning of the 
pass and then the specified mode is turned on. 
 

Language Acceptance 
This software accepts G-Code programs and Heidenhain conversational only. 
 

Offset Commands 
Any work coordinate offset commands which are sensitive to the current work plane must be preceded by the 
appropriate G17, 18, or 19 command. Otherwise, the software will assume the offset to occur with respect to the last 
plane which was converted to arcs. In most cases, you can just add a G17 to the offset command line. 
 

Optimization Failure 
If the software fails to optimize, check to be sure that correct machining methods have been employed in your CAM 
system. Your G-Code should lie on the X-Y, Y-Z, or X-Z planes. 
 

Plane Restrictions 
The software will only output arc moves in the X-Z, Y-Z, or X-Y planes. 
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Appendixes  

ASCII Character Codes 
Decimal Symbol Keystroke 

0 NUL CTRL @ 
1 SOH CRTL A 
2 STX CTRL B 
3 ETX CTRL C 
4 EOT CTRL D 
5 ENQ CTRL E 
6 ACK CTRL F 
7 BEL CTRL G 
8 BS CTRL H 
9 HT CTRL I 
10 LF CTRL J 
11 VT CTRL K 
12 FF CTRL L 
13 CR CTRL M 
14 SO CTRL N 
15 SI CTRL O 
16 DLE CTRL P 
17 DC1 CTRL Q 
18 DC2 CTRL R 
19 DC3 CTRL S 
20 DC4 CTRL T 
21 NAK CTRL U 
22 SYN CTRL V 
23 ETB CTRL W 
24 CAN CTRL X 
25 EM CTRL Y 
26 SS CTRL Z 
27 ESC CTRL [ 
28 FS CTRL % 
29 GS CTRL ] 
30 RS CTRL  ̂
31 US CTRL _ 
32 SP SP 
33 ! ! 
34 " " 
35 # # 
36 $ $ 
37 % % 
38 & & 
39 ' ' 
40 ( ( 
41 ) ) 
42 * * 
43 + + 
44 , , 
45 - - 
46 . . 
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47 / / 
48 0 0 
49 1 1 
50 2 2 
51 3 3 
52 4 4 
53 5 5 
54 6 6 
55 7 7 
56 8 8 
57 9 9 
58 : : 
59 ; ; 
60 < < 
61 = = 
62 > > 
63 ? ? 
64 @ @ 
65 A A 
66 B B 
67 C C 
68 D D 
69 E E 
70 F F 
71 G G 
72 H H 
73 I I 
74 J J 
75 K K 
76 L L 
77 M M 
78 N N 
79 O O 
80 P P 
81 Q Q 
82 R R 
83 S S 
84 T T 
85 U U 
86 V V 
87 W W 
88 X X 
89 Y Y 
90 Z Z 
91 [ [ 
92 \ \ 
93 ] ] 
94 ^ ^ 
95 _ _ 
96 ` ` 
97 a a 
98 b b 
99 c c 
100 d d 
101 e e 
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102 f f 
103 g g 
104 h h 
105 I i 
106 j j 
107 k k 
108 l l 
109 m m 
110 n n 
111 o o 
112 p p 
113 q q 
114 r r 
115 s s 
116 t t 
117 u u 
118 v v 
119 w  w  
120 x x 
121 y y 
122 z z 
123 { { 
124 | | 
125 } } 
126 ~ ~ 
127 DEL DEL 

 
 

Serial Port Diagrams 
The diagrams below show typical software handshake cables for connection to either a 25 pin or a 9 pin computer 
serial port. 
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Contact Support 

Technical Support - USA 

Contact: EZ -CAM Inc., Steve Genther 
Email : sales@ezcamsoft.com 
Phone : 201-420 7360 
Web  :  www.ezcamusa.com  

Technical Support – Germany 
Contact: EZ -CAM Software Gmbh, Malcolm Dearing 
Email : ezcamsoft@aol.com 
Phone : +49 2161-694630 

Technical Support - Japan & Far East 
Contact: FCS International, K. Inoue 
Email : fcsi@fcsi.co.jp 
Phone : +81 462-731433 

Technical Support – England 
Contact: Sodi-Tech E.D.M. Ltd, Stuart Burbage 
Email : stuart@sodi-techedm.co.uk 
Phone : +44 2476-511677 

 
 



 19 

Contents 
Help topics are divided into categories represented by the icons below. To select a category with the mouse, point to 
its icon then click. With the keyboard, press Tab to highlight the category you want then press Enter. To return to this 
screen, select the Contents button at the top of the Help window. If you are using the software for the first time, 
select the "Optimize" icon. It contains a series of procedures which you must complete in order to use the software. 
 

  
 
 

New in Release 6 
The new release 6 of EZ -DNC / FilterMAX comes with some significant improvements over previous versions. What 
follows is a list of the new features and functions with some additional information.  
 
List of important new features: 
1. Full 32Bit support. All controls, functions, routines, dialogs and components have been converted to 32Bit. Support 

of long filenames. 
2. Integration of new Sax Basic Script language. This functionality is accessible through the new automation menu 

and replaces the old proprietary macro language. The Sax Basic Language provides the core language definition 
and  is Visual Basic for Applications(TM) compatible. 

3. New  “Restart from Cursor”  DNC function allows to start sending nc files from any position. 
4. Enhanced optimization functions in FilterMAX 
5. Usage of Recycle Bin for file delete functions 
6. Revised Helpfile 

 
 

The Menu Commands 

Overview   

Select a Topic 

File Menu Commands  
Edit Menu Commands  
Format Menu Commands  
Optimize Menu Commands  
Preview Menu Commands  
DNC Menu Commands  
Automation Menu Commands  
Window Menu Commands  
 

Overview of the Menu Commands 
A command is an instruction that tells the software to do something. You can quickly choose the most common 
commands by using the mouse to click buttons on toolbars. For example, to print the contents of the active window, 
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you click the Print button on the toolbar. 
All commands are grouped on menus. Some commands carry out an action immediately; others display a dialog box 
so that you can select options. 
To choose a command from a toolbar  
On the toolbar, click a button.  
To choose a command from a menu 
1.  Point to a menu name and click the left mouse button. 
2.  Point to a command name and click the left mouse button. 
A command name followed by an ellipsis (...) indicates that the command has additional options you can use to refine 
the function of the command. 
Using the keyboard      To make the menu bar active, press the ALT key and then press the underlined letter in the 
menu name to display a menu. To choose a command, press the underlined letter in the command name. For 
example, to choose Open from the File menu, press ALT, F, O. 
 
Tip 
If you select a menu by mistake, you can close the menu without choosing a command by clicking outside the menu or 
pressing the ESC key. 
 

RS232 Settings... 
When this command is selected, a dialog box will appear allowing the configuration of the communications 
parameters. To determine the parameter settings, refer to the control manual or manufacturer. When the Save 
Settings command is selected from the File menu, the RS232 settings will be saved in the specified parameter file. 
For more information click on the graphic below   

  
 
 

DNC Settings... 
The DNC Settings command is used to configure optional communications parameters that may be required by the 
CNC control. These parameters can be specified by typing an actual literal character, or for nonprintable characters, 
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by specifying the ASCII decimal equivalent with left and right arrow brackets around it. See ASCII character Codes for 
more information on ASCII decimal equivalents. 
For more information click on the graphic below   

  
 
 

DNC Restart Settings 
The DNC Restart function is used to resume sending a program from any text position. The restart position is defined 
by the current cursor position. This function is very useful when restarting transmission of a large program from a 
specific position ( for example after tool damage or tool change). 
For most CNC controls, the restart process is the same as a new file transmission. Depending on the control type, it 
expects a program header with information like tool number, tool offset, feedrate, speed, etc. The “Restart Header” 
textbox  is used to define the program header to provide all that information to the control.  Normally it looks like a start 
section of a standard nc file. Take care to set the correct parameters and be aware of possible formatting restrictions 
of the control. All parameters regarding the communication are set in the DNC Settings dialog. The restart settings can 
be saved together with all other communication parameters by using the Save Settings command in the file menu. 
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When the Automatic renumbering function is activated, the software checks all lines for numbering and automatically 
recalculates them before sending them to the control. The settings for renumbering can be changed by using the 
Renumber Settings dialog in the Edit menu. 
 
There are some more rules that apply to the header text itself: 
• no empty lines allowed, first empty line in the text window marks the end of header 
• maximum of 20 lines are allowed 

• total size of header is limited to 242 characters 
Important  ! 
Software does not check the user input header for wrong settings with respect to tool number or other machining 
parameters. 
Make sure to set the correct machining parameters to avoid tool crashes or workpiece damage !! 
 
 

DNC Restart from Cursor 
This dialog is used to restart a program from any position. 
 
1. Define a Restart Header by using DNC Restart Settings dialog. 
2. Place the cursor in the line where you want to start sending data. 
3. Select DNC Restart from cursor command from the DNC menu (last minute changes to the header can also be 

done here). 
4. Depending on the Flow Control settings get the machine ready first and then  press START button of the 

software or vice versa. 
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Wait for Xon 
This parameter defines any character(s) that must be received by the software before start sending a file to the CNC 
control. This setting is only used when Handshake setting is Xon/Xoff. 
Communication process when using “Wait for Xon” function: 
1. Open the file that is to be send to the machine control 
2. Load the communication settings for that particular control (if not already done) 
3. Select “Send Text” command from the DNC menu . A window displaying the message “Wait for Xon” will 

appear. 
4. Start the receiving function on the machines control. The machine will send the Xon character ( ASCII <17>) and 

the software will automatically start sending the data. 
 
 

Show in Editor 
When this option is activated, the software scrolls through the text in the active text window when it is being sent to the 
control. This takes time and computer resources, as a result the amount of data sent may be reduced dramatically, 
especially  for high baudrates. It is recommended not to turn this option on when sending big files using high 
baudrates as in the case of large 3D programs. 
 
 

Send Text... 
The Send Text command is used to initiate a transfer of the data contained in the active window to the CNC control. 
When this option is selected, a dialog box will be displayed indicating the status of the data transfer. When Xon/Xoff 
Handshake is activated it will also display the message “Wait for Xon”. To cancel the operation, click the Stop button. 
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Receive Text... 
The Receive Text command is used to initiate a data transfer from the CNC control to the active window. When this 
option is selected, a dialog box will be displayed indicating the status of the data transfer. At the begin it shows the 
message “Waiting for text”. When the first characters are received, the text changes to “Receiving Text”. As long as 
the process is ongoing, the mouse cursor  will be flickering. Only after pressing the Stop button, the received data will 
be displayed in the actual text window. 

  
 

Baud Rate 
This setting controls the data transfer rate from one device to another. The baud rate can be set from 110 to 19200. To 
change the baud rate or many of the other options in this dialog box, simply place the cursor inside the circle next to 
the desired setting and click the mouse. 
 

Data Bits 
The Data Bits option can be set to either 7 or 8. This setting defines the character length that is required by the CNC 
control, and should be set accordingly. 
 

Stop Bits 
The stop bits option can be set to either 1 or 2. In most cases, this option should be set to 1. 
 

Parity 
This option can be set to either None, Odd, or Even. If the control requires 8 data bits then this setting would typically 
be set to None. If the control requires 7 data bits then this option should be set to Even. 
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Flow Control 
This setting is used to specify the type of protocol (handshake) used to coordinate the flow of data from the computer 
to the CNC control and vice versa. The way in which the control is designed to communicate and the type of cable 
being used, will most likely dictate which flow control option should be selected. 
 

None 
This option should only be used for simple connections made at extremely low baud rate settings. With this setting , 
the data is transferred without any checks to ensure that one device can receive the file as quickly as the other is 
sending. 
 

Xon/Xoff 
In most cases the Flow Control should be set to Xon/Xoff. This type of transfer protocol is called software 
handshaking. With this option, when the buffer of the receiving device becomes full , an invisible control character 
(DC3 reader stop) is sent to the sending device to temporarily suspend the transmission. When the buffer of the 
receiving device becomes free, a different control character (DC1 reader start) is sent to the sending device and the 
data transfer is resumed. This type of transfer requires that only two data wires (#2 and #3) be used for transferring 
the file as well as managing the flow control. 
 

RTS 
The RTS protocol is used for what is called a hardware handshake interface. This means that the f low control 
management between the sending device and the receiving device is accomplished by using additional cable wires. 
These cable wires act as a switch, by changing their voltages when the receiving devices buffer becomes full, and 
then also, when it can continue receiving again. Since there are several variations on hardware handshake cable 
configurations, it is recommended that the cable configuration be obtained from the control manual or manufacturer. 
 

Xon/RTS 
The Xon/RTS option is a combination of  methods. With this option the flow control is managed by using both control 
characters and the additional cabling connections and therefore also requires a hardware handshake cable 
connection. 
 

Communications Port 
This setting is used to select the desired serial port where the communications cable should be connected to. The list 
only shows  ports that are available for communication (automatically  checked by the software). Number of ports is 
limited 32. 
 

Tip ! 

In case of trouble with the automatic port detection the number of the ports in the listbox can be set manually. This can 
be achieved by editing the PortMax setting in the desired parameter file (*.PAR). If this value is set to a number 
greater 1000  (expl. 1004 => port 1-4), the automatic detection is not used. But remember, limit is still 32 ports. 
 

Program Start (send) 
This option is used to define any additional characters that should be sent when beginning a program transfer to the 
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CNC control. Some controls require a special character to be sent to signal that a transfer is being initiated. 
 

Program End (send) 
This option is used to define any additional characters that need to be sent at the end of the program file, when 
sending to the CNC control. Some controls require that a special character be received before the transmission will be 
terminated and the  file saved. 
 

Block End 
This option is used to define the end of block character(s) required by the CNC control when sending files. Also when 
receiving files from the machine, the software uses this setting to arrange the line that are received. This parameter is 
normally set to <13><10> (carriage return and line feed). For more information on ASCII decimal equivalents refer to 
the  ASCII Character Codes . 
 

Skip Line Prefix (send) 
The Skip Line Prefix option is used to define the start character of any program lines that should be ignored when the 
file is transferring to the CNC control. This is typically used to define the start character of a program comment, 
allowing any comments to stripped from the program during the transfer to the control. 
 

Send Before Receive 
This parameter defines any characters that must be sent to the CNC control to signal the control to begin sending a 
file to the computer. Some controls will not begin sending a file until they receive a special character. This parameter is 
typically set to <17> (DC1 reader start) however any ASCII character may be specified. 
 

Program Start (receive) 
This option is used to tell then software when to begin excepting program information being sent from the control to 
the computer. This parameter is typically set to either % or <13><10> for carriage return and line feed. 
 

Skip Line Prefix (receive) 
This option is used to define the start character of any line that should be ignored when transferring a program from 
the control to the computer. This is typically used to strip any program comments from the file being received. 
 

Send Special... 
When Send Special is selected system starts waiting to receive Program Address + Filename + EOB. When it detects 
this sequence it extracts the filename and adds File Extension to it (standard *.TXT). After searching for the file in the 
current directory system starts waiting for XON from the control. After receiving XON this file is sent directly from the 
harddisk. When transfer is complete system starts waiting for the next filename. Program Address can be customized 
by using Other Settings dialog in the Preview menu . File Extension of the last saved or open file is automatically 
remembered. 
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Undo 
The Undo command reverses actions in the order they were performed. This command will undo the last ten actions 
made in the active window. 

  The Undo button 
 

Cut 
The Cut command is used to delete selected characters from the active window and copy them to the clipboard. Each 
time this command is used, the contents of the clipboard is replaced with the new selection. 

  The Cut button 
 

Copy 
The Copy command is used to copy selected text to the clipboard so that it may be reinserted into any active window. 
Each time text is copied, the contents of the clipboard is replaced with the new selection. This option is useful for 
duplicating repetitive sequences elsewhere w ithin the active window. 

  The Copy button 
 

Paste 
The Paste command is used to insert the contents of the clipboard into any active window at the current cursor 
position. This command does not change the contents of the clipboard. 

  The Paste button 
 

Clear 
The Clear command is used to delete the current selection of the active window without copying it to the clipboard. 
This command provides a way to delete a selection while also protecting the contents of the clipboard. 
 
 

Select all 
The Select All command is used to select the entire contents of the active window. This command is useful when 
making global program edits such as changing the font type or size. 
 
 

Search... 
The Search command is used to locate a specific sequence of characters. This command is useful for locating items 
such as spindle speeds, feed rates, tool changes, program stops, etc.. When this command is selected, a dialog box is 
displayed. It allows you to enter the characters to be searched for and provides choices in how the search is to be 
conducted. A search can be made either forwards or backwards depending on the setting of the Direction button. A 
search will start at the beginning of the file unless the Start at cursor Position check box is chosen. Also, you can 
specify whether to search for the Whole word only as opposed to any occurrence, and can choose to Ignore Case 
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sensitivity by selecting these corresponding check boxes. The search dialog box is displayed below. 

  The Search button 

  
 
 

Search and Replace... 
The Search & Replace command behaves much like the Search command. Unlike the Search command, the Search 
& Replace command allows you to enter both the characters to be searched for and the characters to replace them 
with. This feature is very useful for performing global edits to a program, such as replacing all occurrences of one feed 
rate with a new one. When this command is selected, the Search and Replace dialog box will be displayed. 

  
 
 

Continue Search 
This command will continue the search operation beginning at the current position using the previously specified 
search criteria. 

  The Continue Search button 
 

Compare to File... 
The Compare to File command is used to compare the contents of one file with another. This command activates a 
dialog box which prompts you to select a file for comparison. Once you have selected a file, the system automatically 
compares the two files. The results of the comparison are indicated by red and blue text. 
For example, if you were working in an active window named "File A" and wanted to compare it to a disk file named 
"File B" you would first select "File B" from the dialog box. The resultant file comparison would be displayed in the 



 29 

active window as follows: 
 
All red text indicates that the information is contained in "File A" but not in "File B". 
All blue text indicates that the information is contained in "File B" but not in "File A". 
 
 

Goto Color 
The Goto Color command is used to search for the next occurrence of a color change within the active window. This 
command is especially useful for file comparison. 
 
 

Renumber Settings... 
The Renumber Settings command is used to resequence numbers in the active window. When selected, a dialog box 
will appear prompting for the Start Number, Step Size, Max Number, Min Digits, and Skip Characters.  See below. 

  
 
See also 
Renumber  
 

Renumber 
The Renumber command is used to renumber the contents of the active window according to the criteria entered in 
the Renumber Settings dialog box. 

  The Renumber button 
 
See also 
Renumber Settings...  
 

New 
The New  command creates a new  window. The Window menu will automatically update the list of available windows. 
A check mark next to the name of the file indicates the active window. By default, each new  window is named 
"untitled". New  windows cannot be created in succession. In order to create a second "new" window, the active 
window must contain some type of information. When closing any window, the system will prompt you to save any 
changes. 
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  The New  button 
 

Open... 
The Open command is used to load existing files. Once a file has been loaded, it may be either edited, renumbered, 
or graphically verified. 

  The Open button 
 

Close 
The Close command prompts you to save any changes to the active window and then closes the window. 
 

Seek... 
The Seek command is used to locate and open a text file based on a user-specified set of search criteria. When this 
command is selected, a dialog box will display prompting for the Seek parameters and the directory from where to 
begin the search. Once the search is completed, a dialog box will list all of the files that were found based on the given 
search parameters. The user may then either open a file by selecting it from the list and choosing Open, or continue 
with a new search by choosing Reset. The Seek dialog box is used to specify the seek parameters. 

  The Seek button 
For more information click on the graphic below 
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Seek : The File Selection Window 
This window is displayed when selecting FIND button on the SEEK dialog. According to the previous defined search 
strings and the filetype that was used, all files that have been found are displayed in the upper filelist. The textbox 
below displays the f irst 20 lines of the selected file. By using the OPEN button the currently selected file can be 
opened. 
For more information click on the graphic below  

  
 

Filelist 
This listbox shows all files that have been found using the previously defined search strings. 
 
 

Header Textbox 
This textbox shows the first 20 lines of the actual selected file in the file listbox. 
 
 

Reset Button 
Use this button to go back to the first seek window to define new search strings or change file type setting. 
 
 



 32 

Open Button 
Use this button to open the currently selected file into a new textwindow. 
 
 

Insert... 
The Insert command is used to place the contents of an existing file into a specific location of the active window. When 
insert is selected, a standard file dialog box is displayed allowing the selection of the file to be inserted. The selected 
file is then placed at the current cursor position of the active window. This feature is useful for importing standard 
sequences of events such as tool changes, macros, etc. 
 
 

Delete... 
The Delete command provides a means for deleting unwanted files without the need to use Explorer. When selected, 
a dialog box will display allowing the user to locate and select the file to be deleted. 
 
See also 
Use Recycle Bin  
 

Save 
The Save command is used to save the contents of the active window. If the active window has not been previously 
saved, then a dialog box will display allowing a name to be specified. Once the file has been named, each time this 
command is selected the file will be saved using the current file name that is displayed on the title bar of the window. 

  The Save button 
 
See also 
Save as...  
 

Save as... 
Like the Save command, the Save As command is used to save the contents of the active window. Each time that 
Save As is selected, a file dialog box is displayed allowing a new file name to be entered. When this option is used, 
the current file name will be changed to the new name that is specified. 
 
See also 
Save  
 

Save as DXF... 
This option is used to create a DXF (Direct Exchange Format) geometry file for the active window. This format 
represents each linear and circular move of an NC program file. When this menu is selected a dialog box will appear 
allowing the DXF file name to be specified. This option is very useful for generating arc and line cross-section 
geometry of an optimized program, allowing it to be read back into a CAM system for further surface development or 
design documentation. 
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Load Words... 
The Load Words command is used to load a list of commonly used words into the system. The Word List that you 
create can be used interchangeably with your NC text file. When the Word List is loaded, you must select the Word 
List command from the Format menu to turn it on. 
 
See also 

Word List  
 

Load Settings... 
The Load Settings command is used to load the CNC parameter settings used by the Optimize, Renumber, and 
Preview commands. The parameter file contains all of the formatting details necessary to interpret an NC program of a 
specific control.  

  The Load Settings button 
 

Save Settings... 
The Save Settings command is used to save the current CNC parameter settings used by the Optimize, Renumber, 
and Preview commands. A different parameter file can be saved for each type of CNC control, allowing unique 
settings to be retrieved for each prior to performing a program optimization or verification. 
 
 

Printer Setup 
This command opens the standard windows printer setup dialog.  
 

Print 
The Print command is used to print the contents of the active window. The file will be printed using the default printer 
which can be changed by using Printer Setup command. 

  The Print button 
 
 

Last Files List 
This area is used to display the names last four files that have been worked with. 
 
 

Exit 
The Exit command prompts you to save any unsaved changes to your files and then ends the application. 
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Dialog Box 
A window that displays the available options when you choose a command. 
 

Toolbar 
A bar with buttons that perform some of the most common tasks such as  
opening, saving, and optimizing files. 
 

File Filter 
Conducts a search based on the file extension. For example, if you wanted to search for macro files, you would enter 
*.mac 
 

First Line 
Conducts a search based on information contained in the first line of the file. Files which contain the specified text in 
the first line will be displayed. 
 

Second Line 
Conducts a search based on information contained in the second line of the file. Files which contain the specified text 
in the second line will be displayed. 
 

Any Line 
Conducts a search based on information contained in any line of the file. Files which contain the specified text will be 
displayed. 
 

List of Drives 
Select the drive to be searched. 
 

List of Directories 
Select the directory to be searched. Subdirectories are automatically included. This option is useful for narrowing the 
scope of the search. 
 

Find 
Begins the search. 
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List of Files 
Displays all files in the active directory that match the File Type  setting. 
 

Exit Button 
Cancels the search. 
 

Font... 
The Font command allows you to change the font currently being used by the software. You can specify the style 
(such as bold and, italic), font size, color, and font effects. 
 

  
 

Margins... 
The Margins command is used to define the page settings. When this command is chosen, a dialog box will display 
prompting for the paper width and height, tab spacing, left and right margins, and top and bottom margins. There is 
also a button named Printer value which is used to automatically establish the page settings based on the current 
printer. 
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Single space 
This commands causes every new line to be separated from the previous line by one, one and a half or two  blank 
lines. 
 
 

Gray Background 
This command is used to change the text editor background color from its default of white, to gray. 
 

Automatic Linebreak 
When this option is turned on, any program line that exceeds the working limits of the paper (paper width minus left 
and right margins) will automatically be broken and the remainder of the line will be displayed on the next line. 
Important: 
This option also affects receiving of data via the serial port. If the received text contains no block end characters and 
this option is turned off, all characters that are received are lost after the first line reaches maximum width. 
 
See also 
DNC Settings for information where to set block end characters 
 

Show CR/LF 

When this option is turned on, all characters such as Tab, Carriage Return and Line Feed are displayed  in the 
textwindow. 
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Uppercase 
When this option is turned on, every character that is typed will be forced to appear as upper case regardless of 
whether the shift key is used or not. 
 

Units (Inch/Metric) 
This command toggles the dimension units from Inch to Metric and vice versa. This command must be set to the 
correct units prior to optimizing or graphically verifying a file. 
 
 

Word List 
This command is used to display a list of predefined words. When activated, the Word List window is displayed on the 
right-hand side of the screen. The vertical alignment of this window allows you to work simultaneously with your 
existing file and the Word List. If the contents of the Word List is too large to be displayed at once, it will be displayed 
in a scrollable window. Any line of text that appears in the Word List can be directly inserted into the active window. All 
you have to do is click on a line of text in the Word List window. The selected text will be copied into the active window 
at the current cursor position. Make sure that your cursor is in the correct position before selecting any text from the 
Word List. If you make a mistake, you can click on the Undo button. You may also select multiple lines of text from the 
Word List window. If the information should reside on separate lines, you will have to create the line breaks manually 
by using the vertical bar character "|". The Word List can be toggled on and off by selecting this command. 
 
 

Use Recycle Bin 
This option affects the functionality of the Delete command in the file menu. When activated, the deleted files are 
moved to the windows recycle bin from where they can be restored. Otherwise the files are removed from disk. 
 
 

Getting Started 

Overview   
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First Things First 
Configuring Control Parameters  
Setting Optimization Parameters  
Saving Your Settings  

Working With Files 
Converting NC Files  
Previewing NC Files  
Saving NC Files  
 
 

Overview Installation Information 

The Release 6 of EZ -DNC and FilterMAX is designed to be compatible with Microsoft Windows 32Bit operating 
systems like Windows 95 / 98 or NT4. Please see the following sections for more information on system requirements 
and installation. 

Instructions 

System Requirements  
Installing the Software  
Connecting the Key Ring  
 

Settings... 
The Settings command is used to establish the parameters that are used to control the arc and nurbs fitting 
optimization. When this command is selected, a dialog box is displayed allowing the entry of the arc and nurbs fitting 
tolerances and other formatting options. Once the parameters have been set, they can be saved using the Save 
Settings command located in the File menu. 
For more information click on the graphic below 
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Convert... 
When the Convert command is selected, a file selection dialog will appear allowing the selection of the file to be 
optimized. Once the desired file has been selected, the optimization process begins and a dialog box showing the 
status of the conversion is displayed. When the optimization is complete a dialog box will display showing how many 
blocks were in original file and how many blocks the new program contains. It also displays the percentage of program 
size reduction. The optimized file is loaded into a separate text window. The filename of this window is preset using 
the original filename with the new extension „FMX“ . The new file can then be verified, saved to disk, or sent directly to 
a machine  control. 
The time required to optimize a file depends on several factors including the size of the file and the tolerances that are 
specified. In general, several minutes will be required to complete the process. 
 

Convert to Directory 
When using this option, the optimized files are stored directly on the harddisk instead of loading them into separate 
MDI text windows as with the „Convert“ option. The system uses same directory and original filename with the 
extension „FMX“ for the new file. Multiple files can be converted at once by using “*” and a valid extension as the 
name of the input file. 
 

Type 
This setting gives you a list of 5 options to define the type of output commands for an optimized file.  

Planar Arcs  
Only moves on XY, XZ and YZ plane are output as arc moves corresponding to the selected/active machine 
control setting. All others will be linear moves. 

Bridgeport Bezier 
All optimized moves are output in the special „Bezier“ format (G7) available on actual Bridgeport 3D controls 
(EZ-TRAK). 

Fanuc Nurbs  
All optimized moves are output in the special „Nurbs“ format (G6.2) available as an option for fanuc 3D 
controls. 

Fanuc 3D Arcs  
All optimized moves are output in the special „Nurbs“ format (G2.4) available as an option for fanuc 3D 
controls. 

Only Corners 
Only corner and feedrate optimization  without arc fitting. 

 

Chordal Tolerance 
The Chordal Tolerance controls how closely the arc moves will be fitted to the points of the original linear moves. 
 

Tangency Tolerance 
The Tangency Tolerance controls how closely each arc is placed to being tangent to the adjacent move. Setting the 
tolerance to a smaller value will ensure that the newly fitted arcs are placed more smoothly from one to another. 
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Decimal Digits 
The Decimal Digits setting controls the number of places after the decimal point that the arc coordinates will be output 
in the NC program. 
 

Comment Prefix 
This parameter defines the start character for a program comment. The purpose of this option is to provide a means to 
specify a new chordal tolerance and tangency tolerance for different operations within a program. This feature is useful 
for controlling tolerances based on the type of operation. If the program does not contain any comments with tolerance 
settings, then the entire program will be optimized using the Chordal Tolerance and Tangency Tolerance specified in 
the Optimization dialog box. 
 

Single Quadrant 
Check this option if your control does not support arcs crossing multiple quadrants. 
 

Corner Optimization 
When this option is activated, the software calculates the angle between consecutive moves. If the angle is bigger 
than “Corner Angle” then fillet radius and feedrate slowdown modifications are applied. 
First operation: 
The software tries to insert a fillet with “Max Corner Radius”. If this fillet can not be inserted then other fillet radii 
between “Max Corner Radius” and “Min Corner Radius” are tried. If a successful radius is found then the distance 
between the inserted fillet circle and corner point is calculated. If this distance is less than “Corner Tolerance” then 
fillet is output into the G-Code file.  
Second operation: 
Feedrate modification is applied depending on the fillet radius from the first operation. If no fillet could be inserted then 
“Min Corner Feed” is selected. Otherwise a feedrate between “Max Corner Feed” and “Min Corner Feed” is selected 
depending on the fillet radius. 
Example: 
Max Corner Radius : 0.01 mm 
Min Corner Radius : 0.001 mm 
Max Corner Feed : 200 mm/min 
Min Corner Feed : 50 mm/min 

Result with corner radius: 0.01mm    ð  Feedrate: 200mm/min 

Result with corner radius: 0.005mm    ð   Feedrate: 125mm/min 

Result with Successful corner radius: 0.001mm  ð  Feedrate:   50mm/min 
 
 

Corner Angle 
There is no filleting in case the calculated corner angle between two consecutive elements is smaller than this setting. 
 
 

Corner Max. / Min. Radius 
When inserting a fillet, the software tries to use “Max Corner Radius”. If this fillet can not be inserted then other fillet 
radii between “ Corner Max. Radius” and “ Corner Min. Radius” are tried ( with approx. 20 steps in size between). If a 
successful radius is found then the distance between the inserted fillet circle and corner point is calculated. If this 
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distance is less than “Corner Tolerance” then fillet is output into the G-Code file corresponding to the Type setting. 
 
 

Corner Max. / Min. Feed 
When optimizing, feedrate modification is applied depending on the fillet radius from the first optimizing operation. If no 
fillet could be inserted then “Min Corner Feed” is selected. Otherwise a feedrate between “Max Corner Feed” and 
“Min Corner Feed” is selected depending on the fillet radius. 
Example: 
Max Corner Radius : 0.01 mm 
Min Corner Radius : 0.001 mm 
Max Corner Feed : 200 mm/min 
Min Corner Feed : 50 mm/min 

Result with corner radius: 0.01mm    ð  Feedrate: 200mm/min 

Result with corner radius: 0.005mm    ð   Feedrate: 125mm/min 

Result with Successful corner radius: 0.001mm  ð  Feedrate:   50mm/min 
 

Corner Deceleration 
For this parameter the “Deceleration” constant of the machine tool control should be input. This constant is in 
(mm/sec) / sec and specifies the amount of feedrate (mm/sec) which can be changed per second. For more 
information about the appropriate value for your machine see the controls handbooks, parameter files or ask your local 
machine tool dealer. 
Example: 
Corner Deceleration  = 1,000,000 (mm/min)/min 
Feedrate in the original G-Code File = 1000mm/min 
Selected Corner Feedrate = 125mm/min 
Calculated distance needed to slow down from F1000 to F125 : 
 

ð  (1000 x 1000 – 125 x 125) / (2 x 1,000,000) = 0.49 mm 
 
In this example software would output F125 command 0.49mm before the corner point (or corner radius). If 
deceleration value is set to 0 then no feedrate optimization is applied and F125 command will be output with the fillet 
move. 
 

Corner Tolerance 
There is no filleting if the distance between the inserted fillet circle and corner point is bigger then this parameter. 

Register Settings... 
The Register Settings command is used to describe the specific word formatting of an NC file that is to be optimized 
using the Optimize command or verified using the Preview command. The letter address for each program word (i.e. 
axis coordinates, spindle speed, feed rate, etc.) can be specified. Also, a factor value can be applied to each word 
allowing the software to interpret a word as being a different value then was read from the NC program. By default, the 
software assumes that a file that is programmed in Inch will have four places after the decimal point, and that the 
decimal point will be included with each word's value. For some controls it may be necessary to use these factors to 
achieve the desired graphic verification.  For instance, if a control does not use decimal point programming but uses 
trailing zeros format instead, then a Factor value of .0001 could be used to tell the software that the decimal point 
position is four digits from the right. 
For more information click on the graphic below  
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See also 
Configuring Control Parameters  
 

Preview / X-Axis 
Address of horizontal milling axis ( X ). For lathe operations the X-Axis is automatically displayed as vertical axis and 
in case of diameter input the factor has to be set to 0.5. 
 

Preview / Y-Axis 
Address of vertical axis for milling operations ( Y ). 
 

Preview / Z-Axis 
Address of 3’thrd (depth) axis for milling operations. For lathe the Z-Axis is automatically displayed as horizontal axis. 
 

Preview / X-Increment 
Address for incremental movements of the horizontal (milling ) or vertical (lathe) axis (default “U”). Some controls (for 
exam. Fanuc lathe controls ) use different axis addresses for incremental moves instead of standard G90/G91 
settings. 
 

Preview / Y-Increment 
Address for incremental movements of the vertical (milling ) axis (default “V”). 
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Preview / Z-Increment 
Address for incremental movements of the 3’thrd (depth for milling ) or horizontal (lathe) axis (default “W”). Some 
controls (for examp. Fanuc lathe controls ) use different axis addresses for incremental moves instead of standard 
G90/G91 settings. 
 

Preview / X,Y,Z-Arc 
Circle center address. 
X-Arc  ð Address of horizontal axis circle center (default “I”) 
Y-Arc  ð Address of vertical axis circle center (default “J”) 
Z-Arc  ð Address of 3’thrd (depth) axis circle center (default “K”) 
 

Preview / R-Arc 
Address for arc radius when using radius input for arc definition. As a standard , arcs < 180° are defined using positive 
radius values. For arcs > 180° the radius value is defined by a negative value. For some controls ( expl. Bosch 
CC100) this may just be the opposite way. In that case use a negative factor (-1.0). 
 

Preview / Feed 
Feedrate address for standard milling and lathe operations (default “F”) 
 

Preview / Drill Depth 
Drill depth when using canned cycles (default “Z”). 
Factor settings for interpretation of input value: 
Factor =  1.0  => absolute 
Factor = -1.0  => incremental 
Factor =  0  => based on G90/91 setting 
 

Preview / Retract Pln 
Retract plane when using canned cycles (default “R”). 
Factor settings for interpretation of input value: 
Factor =  1.0  => absolute 
Factor = -1.0  => incremental 
Factor =  0  => based on G90/91 setting 
 

Preview / Cut-In 
Incremental depth for Chipbreak or Deephole canned cycles (default “Q”) 
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Preview / Feed-Drill 
Feedrate when using canned cycles (default “F”) 

 

Preview / Dwell 
Dwell time address. Sometimes dwell time in defined by using 1/1000 seconds. In that case use “0.001” as factor 
setting. 
 

Preview / RPM 
Address for spindle speed in revolutions per minute 
 

Preview / Pitch 
Address for pitch setting when using pitch (inch / rev.) instead of standard feedrate ( inch / minute) setting in canned 
tapping cycle. Default setting “S”. 
 

G-Code Settings... 
This command is used to describe the specific G-Codes of the NC file that will be executed in Preview. When 
selected, this menu will display a dialog box containing parameters for defining Z-Axis canned cycles and other 
commonly used G-Codes. The Skip Line option is used to define the control's block skip character so that Preview will 
ignore any program lines that are preceded with the this character. Any G-Code settings that are not applicable can be 
ignored when defining these parameters. 
For more information click on the graphic below  

  
 
Note 
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Although many of the NC-Codes are user configurable, some of them are not. Following is a list of all of the codes that 
are recognized by the software. These codes cannot be redefined by the user. 
Interpolation Codes G0,G1, G2, G3, G12, G13 
Plane Selection  G17, G18, G19 
Absolute / Incremental G90, G91 
Program End  M2, M30 
Return to Initial Point / Return to R Point (Canned Cycles) G98, G99 
 
See also 

Configuring Control Parameters  
 

Preview / Drilling 
Drilling canned cycle command (default  G81). 
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill( See Register Settings dialog ) 
Rapid (units/min)   ( See Other Settings dialog ) 
 

Preview / Spotfacing 
Spotfacing canned cycle command (default  G82). Drill cycle with dwell time when reaching depth. 
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill , Dwell ( See Register Settings dialog ) 
Rapid (units/min)    ( See Other Settings dialog ) 
 

Preview / Chipbreak 
Chipbreak canned cycle command (default  G73). Drill cycle with a short rapid retract move after every cut-in step for 
chip breaking. 
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill , Cut-in ( See Register Settings dialog ) 
Rapid (units/min)    ( See Other Settings dialog ) 
 

Preview / Deephole 
Deephole canned cycle command (default  G83). Drill cycle with a complete rapid retract move after every cut-in step 
for chip removal. 
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill , Cut-in ( See Register Settings dialog ) 
Rapid (units/min)    ( See Other Settings dialog ) 
 

Preview / Reaming 
Reaming canned cycle command (default  G85). Drill cycle with depth and retract moves by using feedrate setting. 
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Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill( See Register Settings dialog ) 
 

Preview / Boring (Ortg.) 
Boring canned cycle command (default  G76). Drill cycle with spindle orientation when reaching depth.  
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill( See Register Settings dialog ) 
Rapid (units/min) ,  Orientation(sec)( See Other Settings dialog ) 

Note 
At the bottom of each hole, the software adds time for spindle orientation. As this is depending on the spindle speed, 
an average time ( Orientation (sec) ) can be set. 

 

Preview / Boring (Stop) 
Boring canned cycle command (default  G76). Drill cycle w ith spindle stop when reaching depth. 
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill( See Register Settings dialog ) 
Rapid (units/min) ,  Stop    ( See Other Settings dialog ) 
Note 
At the bottom of each hole, the software adds time for spindle stop. As this is depending on the spindle speed, an 
average time ( Stop ) can be set. 
 

Preview / Tapping 
Tapping canned cycle command (default  G84). 
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill( See Register Settings dialog ) 
Rapid (units/min) ,  Reversing ( See Other Settings dialog ) 
Note 
At the bottom of each hole, the software adds time for spindle reversing. As the time for reversing is depending on the 
spindle speed, an average time ( Reversing ) can be set. 
 

Preview / Rev.Tapping 
Reverse Tapping canned cycle command (default  G74). 
 
Following parameters are used for time calculation: 
Retract Pln , Drill-Depth , Feed-Drill( See Register Settings dialog ) 
Rapid (units/min) ,  Reversing ( See Other Settings dialog ) 
Note 
At the bottom of each hole, the software adds time for spindle reversing. As the time for reversing is depending on the 
spindle speed, an average time ( Reversing ) can be set. 
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Preview / Turn-Thread 
Thread command (default  G32) for lathe simulation (only one pass, retraction by using rapid feedrate) 
 

Preview / Const-Surf 
Command (default  G96) when using constant feedrate setting (inch/min or mm/min) for lathe simulation. The spindle 
speed varies with the workpiece diameter. The spindle speed is therefore very often limited by special commands for 
safety of workpiece. 
Following parameters are used for time calculation: 
Max.RPM  ( See Register Settings dialog ) 
 

Preview / Const-Spind 
Command (default  G97) when using constant spindle speed setting (rpm/min) for lathe simulation 
Following parameters are used for time calculation: 
Max.RPM  ( See Register Settings dialog ) 
 

Preview / Units/Rev. 
Lathe command (default  G99) for calculating feedrate moves by using mm/rev setting. 
Following parameters are used for time calculation: 
Units(rev) ( See Register Settings dialog ) 
 

Preview / Units/min 
Lathe command (default  G98) for calculating feedrate moves by using mm/min setting. 
Following parameters are used for time calculation: 
Units(min) ( See Register Settings dialog ) 
 

Preview / Max.RPM 
Lathe command (default  G50) for limiting spindle speed. 
 

Preview / Skip Line 1-3 
Code lines containing one of the characters or text sequences defined here are skipped during simulation. 
 

Other Settings... 
The Other Settings command is used to describe specific details of the CNC machine and control for which the NC file 
was written. These settings are used by Optimize and Preview when interpreting an NC file. There are parameter 
settings for defining the letter addresses and M-Codes for macros, tool numbers, tool changes, and special functions 
such as pallet changes, rotary table indexing, etc.. There are also settings that can be used to define the rapid rate 
and the times required for various operations, allowing for more accurate Preview time calculations.  
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For more information click on the graphic below 

  
 
See also 

Configuring Control Parameters  
 

Preview / Control Type 
This option is used to specify the type of machine for which an NC program was written. When this item is selected a 
list of three machine types will display, Mill-FANUC, Turn-FANUC, and Mill-HEIDENHAIN. For most conventional G-
Code Mills and Lathes the Fanuc options should be used. The Heidenhain option is only intended to be used for 
milling programs that are written in Heidenhain conversational format. 
 

Preview / Program Address 
Definition of program address (default  0). For example Fanuc:  O2000  ð Program number 2000. This setting is used 
by the Send Special command to detect the Address/Name of the program that is requested by sending a dummy text 
from the control to the PC. 
 

Preview / Macro Call 
Definition of macro call address (default  M98 for Fanuc). 
Example: 
M98 P2000  ð Call of subprogram number 2000.  
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Preview / Macro Address 
Definition of macro call address (default  M98) . 
Example : 
M98 P2000  ð Call of subprogram number 2000.  
 

Preview / Macro Start 
Definition of macro start section address (default  O) . 
Example : 
. . . 
( Main program ) 
. . . 
G91 G28 Z0 M05 
M30 
O2000 
. . . . 
( sub program) 
. . . . 
M99 
 

Preview / Macro End 
Definition of macro end section address (default  M99) . 
Example : 
. . . 
( Main program ) 
. . . 
G91 G28 Z0 M05 
M30 
O2000 
. . . . 
( sub program) 
. . . . 
M99 
 

Preview / Macro Repeat 
Definition of macro repeat command  (default  L) . 
Example : 
M98 P2000 L10 ð Call of subprogram number 2000 and execute it 10 times.  
 

Preview / Tool Address 
Tool number address  (default  T) . 
 

Preview / Tool Change 
Tool change command  (default  M06) . 
 



 50 

Preview / Change Time 
Tool change time (default  8 sec) . 
 

Preview / Rapid  
Rapid feedrate in units / sec. 
 

Preview / Arc Center Definition 
Definition of arc center programming mode. 
Possible settings: 
Incremental I,J,K :  Definition of circle center always in incremental mode. 

   Distances (values) are measured from startpoint of circle 
   to midpoint. 

Absolute I,J,K :  Definition of circle center always in absolute mode. 
 

Incremental + absolute  :  Definition of circle center always depending on the actual mode setting (G90/G91). 
Note: 
Settings are only used for Preview when “machine type”  is not set to “Mill-Heidenhain”. 
 

Preview / Orientation 
This setting is used to specify the time required to stop and orient the spindle when using a boring cycle that supports 
this function. When Preview encounters the G-Code that is specified in the Boring (ortg) cycle, the orientation time will 
be added to the calculation time for each hole that is being bored. If your machine does not support spindle 
orientation, this value can be set to zero so that the time calculation will not be affected. 
 

Preview / Stop 
This settings is used to specify the time required to stop the spindle when using a boring cycle that stops the spindle 
before retracting. When Preview encounters the G-Code that is specified in the Boring (stop) cycle, the stop time will 
be added to the calculation time for each hole that is being bored. 
 

Preview / Reversing 
This parameter is used to specify the time required to reverse the spindle when a tapping cycle is used. Each time that 
Preview encounters the G-Code that is specified in the Tapping cycle, the reverse time will be added to the time 
calculation for each hole that is being tapped. 
 

Preview / Special Func 
This setting allows  to define a command that may occur in the nc-code and for which a time should be calculated. For 
example some kind of special M-function for bar feeder operations. The time that is calculated when this command is 
detected, is defined under the Func Time setting in the “Other Settings” dialog. 
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Preview / FuncTime 
Definition of the time (sec) that is calculated when the Special Func command is detected. 
 

Preview / Retraction 
This setting is used to specify the retraction distance used by the chip break  drilling cycles. Each time that Preview 
encounters the G-Code that is specified in the Chip Break cycle, the retract distance will be figured into the time 
calculation for each hole. 
 

Preview / Start Drill next block 
This option is used to define when the Z-Axis canned cycles are initiated. Most machines will activate the canned cycle 
at the current location as soon a the G-Code is read. Some controls however, will not execute the canned cycle until 
the following block, in this case the Start Drill Next Block option should be selected. 
 

Preview / Ignore Z 
If this setting is activated, the system skips all “Z” axis command / parameters in lines where drilling operation are 
performed. 
 

Preview / Use Pitch 
If activated, the system uses pitch (inch or mm / round) instead of Drill-Feed commands for time calculation in tapping 
cycles. 
 

Preview / Reverse Arcs in G17/18/19  
This setting reverses simulation of standard arc direction (G02/G03)  in G17/18/19 plane. 
 

Preview... 
The Preview command is used to begin the verification process. When this command is selected, a new window will 
be displayed. There are six buttons that are used to control the verification process. 

  The Preview button 
For more information click on the graphic below 
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Run Single Step 
This button is used to verify a program one block at a time. Each time the button is selected, the next program line is 
read. 
 

Stop 
The Stop button is used to pause the tool path verification. The verification can be restarted from the current position 
by choosing either the Run Single Block or Run Continuous button.  
 

Run Continuous 
When this button is selected, the program will begin verifying from the current position, executing each program block 
until the end of the file is reached or until the Stop button is selected. 
 

Rewind and Clear 
This button is used to rewind the NC file back to its beginning while clearing the graphics display of the previous 
verification.  
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View Settings 
When this button is selected, a dialog box will display, allowing the entry of the desired Window Center coordinates, 
and the Window Size. There is also a view selection list that allows any standard view orientation to be selected. Four 
check boxes are available to select options to Print, AutoRedraw, Show Path, and Show Points. 
For more information click on the graphic below  

  
 
 

Activate Text Editor 
When this button is selected the text editor window is activated and the Preview window is closed. 
 

Tool 
Displays the current tool being used during the machining process. 
 

Tm (Time) 
Displays the estimated machining time. 
 

Display Area 
The display area is used to preview the toolpath of your part. The display area is dynamic. You may zoom in or out 
while previewing. 

 

See also 

Controlling toolpath verification by using Preview Shortcuts  
 

Preview Shortcuts 
There are some shortcuts that provide functions to ZOOM, PAN or MOVE the view of the toolpath inside the preview 
window. 
Ctrl + Mouse Click 
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The simulation coordinate center is moved to the actual cursor location. Rewind and start simulation to verify toolpath 
with the new center position. 
Alt +  Mouse click 
The simulation coordinate center is moved to the actual cursor location and the size of the displayed area is multiplied 
by factor 2. Rewind and start simulation to verify toolpath with the new center position. 
 Shift +  Mouse click 
The simulation coordinate center is moved to the actual cursor location and the window is zoomed by factor 2. Rewind 
and start simulation to verify toolpath with the new center position. 
Selecting Free Zoom Window  
For free zooming just click at one corner of the area you want to zoom. Keep the left mouse button pressed and drag 
the mouse over  the preview window. You will see a frame moving with the cursor. When you release the mouse 
button the actual preview window is set automatically to the size and center of the previously selected zoom window. 
Rewind and start simulation to verify toolpath within the new window. 

  
 

Preview / Window Centers 
These settings define the absolute coordinate center  and the size of the preview window for the XYZ axes in Inch or 
MM depending on the Units setting in the format menu. 
 

Preview / Step Size 
The Step Size option is used to control the number of program lines that will be executed each time that the Run 
Single Step option is used. 
 

Preview / Auto Redraw 
If this option is toggled on, you can move the preview window across the windows desktop and the previously verified 
toolpath is still visible on the new location because the windows operating system always keeps a bitmap copy in the 
memory to restore the previous view. This of course takes a lot of system resources and significantly slows down 
verification speed. Therefore this option is toggled to off by default. 
 

Preview / Print 
If this option is toggled on, a picture of the verified toolpath is automatically send to the printer after verification if 
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finished 
 

Preview / Showpath 
This option allows simulation of the tool diameter if XY view in the preview window is activated. The tool diameter is 
defined by a special comment directly in the nc program code. 
(*DIA 0.05) Comment Tooldiameter = 0.05 inch 
Code example: 
% 
(MILL8-27-93) 
G91G28Z0M5 
T1M6 (*DIA0.05)  Toolchange command and special comment defining simulation diameter 
G80G90G0G17G40G98 

  
 

Preview / Showpoints 
When this option is activated, the software shows small circles on the start and endpoints of every verified element 
(lines, circles). 



 56 

  
 
 

Toolpath Preview 

Overview   

Using Preview 

Preview...  
Zooming In  
Changing the Window Center  
Zooming In by Two  
Zooming Out by Two  
Default Display Area Settings  
 

Overview of Toolpath Preview 
The Preview command is used to graphically simulate the machine tool's execution of the NC program. An active 
window must be displayed before the Preview command can be used. Since the Convert command automatically 
loads the file into an active window, the Preview command can be used immediately after converting a file. 
To begin previewing a file, choose the Preview command from the Preview menu. A new window will appear placed 
on top of the existing window. The Preview window contains six buttons along the top of the window. Four of these 
buttons function similar to a VCR, allowing a file to be played in single steps, played continuously, stopped, or 
rewound to the beginning of the file. There is also a button used to adjust the viewing parameters such as the window 
center coordinates, the window size, or the 3D view orientation. This button appears as an X-Y axis. 
The simulation is started by choosing the button that has two arrows pointed toward the right of the screen (Run 
Continuous). Assuming that the view settings are adjusted correctly, the program tool path will display in the Preview 
window . The verification may be stopped at any time by selecting the button that contains a single square (Stop). To 
replay the simulation choose the button that contains two arrows pointed toward the left of the screen (Rewind and 
Clear) to rewind the file. To verify the program in a single step mode, choose the button that contains a single arrow 
pointed toward the right of the screen (Run Single Step).  
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Zooming In 
To enlarge the display of the NC file verification, use the mouse to create a zoom box, by placing the cursor at a 
corner of the desired zoom window, and click the mouse, continuing to hold the mouse button down while moving the 
cursor to the diagonally opposite corner of the desired window. When the zoom box is sized as desired, release the 
mouse button and the screen will be zoomed in. Restart the simulation to verify the toolpath in the new window. 
 

Changing the Window Center 
To change the window center, place the cursor at the desired center position and click the mouse while holding down 
the CTRL key. 
 

Zooming In by Two 
To zoom in by a factor of two, place the cursor at the desired center position and click the mouse while holding down 
the SHIFT key. 
 

Zooming Out by Two 
To zoom out by a factor of two, place the cursor at the desired center position and click the mouse while holding down 
the ALT key. 
 

Default Display Area Settings 
When optimizing files, the optimization process automatically sets the window center and size parameters so that the 
part can be viewed in its entirety. Should you dynamically zoom in and out while previewing the part, you may want to 
keep in mind the following default settings: 
US(Inch) 
Window Center -X    0 
Window Center -Y    0 
Window Center -Z    0 
Window Size   20 
Metric 
Window Center -X   0 
Window Center -Y   0 
Window Center -Z   0 
Window Size  500 
 
 

Toolbar Buttons 

Overview   

Click on the buttons for more information. 
 

 Creates a new file.       Opens an existing file. 
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 Searches for a file in any directory.      Saves the file. 
 

  Loads machine settings     Prints the contents of the file. 
 

  Reverses changes (Undo command).    Cuts the selection to the clipboard. 
 

  Copies the selection to the clipboard.    Pastes contents of the clipboard. 
 

  Searches for specified text.     Repeats the last search. 
 

  Renumbers the file.      Optimizes the file. 
 

  Activates the toolpath preview.     Sends data to the machine control. 
 

  Receives data from the machine control. 
 

Overview of Toolbar Buttons 
As previously mentioned, one of the uses of this software is for NC file editing. To make the process of editing a file 
more convenient, a toolbar containing frequently used commands in the form of buttons, are placed across the top of 
the edit window just below the pull down menus. The toolbar buttons can be accessed at anytime without the need to 
choose a command from a menu. 
 
 

Cascade 
Arranges the windows so they overlap, starting in the upper-left corner of the window. The title bar of each window 
remains visible, making it easy for you to select any window. 
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Horizontal 
Arranges the windows horizontally, making it easy for you to compare the contents of individual files. The top window 
will be the active window. Only one window can be active at a time. To make another window active, click the title bar. 

  
 
 

Vertical 
Arranges the windows vertically, making it easy for you to compare the contents of individual files. The left window will 
be the active window. Only one window can be active at a time. To make another window active, click the title bar. 
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Display windows / Actual Filenames 
This area is used to switch between the open MDI textwindows. Normally the filenames of the actual loaded files are 
displayed. If no filename has been assigned yet,  “untitled” will be displayed. 
 

New Window 
This option opens a new textwindow. It is the same functionality as the New  command in the file menu. 
 

Arrange icons 
This option is used to arrange the icons of all minimized textwindow in the lower leftmost area of the main window. 

  
 
 

Macro Editor 

This command opens the Sax Basic Editor. This is an interactive design environment for developing, testing and 
executing Sax Basic scripts. For more information about the editor and basic script development please see Sax 
basic Help. 
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Macro Directory 

All basic script files should normally be located in one “macro” directory. This command is used to open a standard 
windows dialog to select and define the standard macro directory. After a directory is selected, it is scanned for *.bas 
files. All files that are found are displayed with their filenames inside the macro list in the automation menu from 
where they can be started . The selected macro directory is automatically stored in the software’s initialization files to 
be remembered for the next sessions. 
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Update menu 

This command is used to scan the actual macro directory for *.bas files. All files that are found are displayed with 
their filenames inside the macro list in the automation menu from where they can be started. Each time a new macro 
has been developed and stored in the actual macro directory, this command has to be used to show the name of the 
new macro in the macro list. 

 

Macro List 
This menu area is used to list and start macros (*.bas files) that are available in the actual macro directory. The list is 
updated when the software is started, a new macro directory is selected, or when the Update menu command is 
used.  
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